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About this manual  
This manual will provide you with a quick overview of the PiCo Logging Application functions. 
Happy reading!  
 
Please note: TSL reserve the rights to change the content of this manual at any time.  The latest revision of this 
manual can be downloaded from: www.tsl.co.uk/products 

Important Notes 
Disclaimer 

No part of this document may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, including photocopying and scanning, for any purpose, without the prior written consent of TSL A/S. 
The company aims to ensure that all details in this document are correct at the time of publication, but reserves 
the right to alter specifications and equipment without notice. The latest version will be available upon request. 
This publication is for international usage. 
Despite considerable effort to produce up to date information, no literature published by the company nor any 
other material that may be provided should be regarded as an infallible guide to the specifications available nor 
does it constitute an offer for sale of any particular product. 

Warranty Maintenance and Repair 

 All TSL products have a one year warranty period starting from the date it leaves the factory.  
 A repair warranty is to apply. That is, the  product is to be  re turned for repa ir with no replacement and  
an exchange shipping policy is also to apply. 
 TSL offers a  seven day DOA policy together with an exchange shipping policy. That is, if a product has  
been declared ‘dead on arrival’ within a seven day period a warranty replacement will be shipped. 
 A temporary replacement may be  ava ilable  where , for ope ra tiona l reasons, it is imperative that  
service is continued. The customer will be asked to enter into a ‘loan agreement’ for the duration of  
repair. 
 All faulty equipment re turned to TSL for repa ir will, where  possible , be  re turned to the  customer  
within seven working days. 

TSL Returns Procedure 

Please telephone +44 (0)1628 6762221 (Fax: +44 (0)1682 676299) and ask for Customer Support, detailing the  
model and serial number of the equipment, who will provide a Returns Number. This will enable us to track  
the unit effectively and will provide some information prior to the unit arriving. 
 
For each item, this unique Returns Number must be included with the Fault Report sent with the unit. 
 
A contact name and telephone number are also required with the Fault Report sent with the unit. 

Fault report details required 

 Company:  
 Name:   
 Address:  
 Contact Name:  
 Telephone  number:  
 Fax number:  
 Email address:  
 Returns Number:  

http://www.tsl.co.uk/products
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 Symptoms of the  fault  (to include  switch se tting positions, input signa ls e tc): 

Purpose 

Any fitness for purpose legislation or other determination that may be applied in the area where this equipment 
is installed must take due cognisance that it is designed for use in professional broadcast, audio and video 
systems by appropriately trained personnel. The equipment is not intended for use in a domestic environment 
and regulations designed for such situations are not applicable. 

After sales modifications 

Any modifications to the equipment not specifically authorised and approved by TSL Professional Products 
may invalidate the equipment warranty. This includes changes to cabling and variations to the recommended  
installation as detailed in the documentation issued by TSL Professional Products. Modifications can invalidate  
EMC and safety features designed into this equipment and the manufacturer cannot be liable for any legal  
proceedings or problems that may arise relating to such modifications. No sales agent or other person involved  
in the supply chain is permitted to authorise variations from the content of this documentation. 

Important Safety Instructions 

 Read these  instructions. Study carefully and understand a ll sa fe ty and opera ting instructions before   
you install and operate the unit! 
 Keep the se  instructions. Keep a ll sa fe ty and operating instructions for future reference! 
 Heed a ll warnings on the  unit and in the  safe ty and opera ting instructions before you install and  
operate the unit! 
 Follow a ll instructions to ensure  aga inst injury to yourse lf and damage to the  unit  or othe r objects  
connected to the unit. 
 To prevent possible  e lectrica l shock, dea th, fire ,  injurie s and malfunctions, use  this product only as  
specified. 
 Only use  a ttachments and accessories specified by the  manufacturer. 
 The units of the  PAM PiCo range are  designed for indoor use only 
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PiCo Logging Application 
About the PiCo Logging PC Application 
The PiCo Logging PC application allows you to instantly document, visualize and evaluate the loudness data of 
the PAM PiCo on your computer.  

Suitable for …. 

The PiCo Logging PC application is compatible with all PAM PiCos. The Logging license is optional for some PAM 
PiCos, while included with others.  
Please check your PAM PiCo owner’s manual to clarify where the Logging license applies.   
 
Please make sure that you run the latest PAM PiCo Application software. Refer to the ‘How to software update 
PAM PiCo’ paragraph for more information on this. 

System Requirements 

The PiCo Logging application is compatible with Windows XP sp3 & Windows 7.  
PAM PiCo application software released later than 10-04-2013. 
 

Where to get a hold of the PiCo Logging Application 
The Logging application itself is free of charge and may be downloaded from www.tsl.co.uk/products.aspx at any 
point in time.  
 
In order to enable the Logging application, your PAM PiCo is required to have the correct software license 
installed. To upgrade your meter, please contact TSL for further information. 
      

Connecting Your PAM PiCo  
There are a couple of basic steps that you have to go through to prepare for Logging data:  

1. Connect your Meter to your PC 
2. Select or create the data base where the Logging Sessions will reside 
3. Select your meter as the data source of logging information. 

 
Here a few easy steps to up and running in a couple of minutes:  
 

Connecting PAM PiCo to your PC 

This is as simple as plugging the USB connector of the PAM PiCo cable into your computer. 
 

Selecting or Creating the Logging Database 

- Open the PiCo Logging Application  
- The first time you open the application, you will be prompted to create or select the database hosting 

your Logging sessions. 
- If not prompted please select ‘Manage databases’ from the ‘File’ dropdown menu 

http://www.dk-technologies.com/
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- Right-click on the ‘Local databases’ line and select ‘Create new local database’ 
- This will allow you to create and name a home for all your coming Logging sessions. 

 
- In case you already have created a database from earlier use of the PiCo Logging Application, right-click 

and select ‘Connect to local database’- This will allow you to select the specific database that you would 
like your logging sessions to be stored inside.  
 

NOTE: More details on the database structure are available in the Logging Session Database View section. 

Selecting your instrument 

- Now select ‘Manage Instrument’ from the ‘File’ dropdown menu.  
- From the pop-up, select the appropriate COM port corresponding to your meter and click ‘OK’ 
- The PiCo Logging Application returns a message saying: ”a new instrument was selected” 
- After returning to the ‘Logging’ window, hit the ‘Connect’ button and you are ready to start logging 

loudness data 

 
 

- In case your instrument COM port does not show up, right click and select ’Find Instrument’. The 
Logging application will now scan to find your instrument 

- Now select your instrument and hit ‘OK’. 
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The Windows & Functions 
Window Overview  
This section will provide you with a quick overview of the various buttons, screens and information fields that 
you will see in the Logging Application. Each of the different windows and functions are described in further 
detail below.  
 

 
 
 

1. File and Tools drop-down menus 
2. Selection of Logging Session or Logging 

Database view 
3. Connecting/Disconnecting the Logging App. 

to your meter and Start/Stop of Logging 
Session 

4. Session Information – Specific to the current 
Logging Session  

5. Instrument information of the currently 
connected instrument 

 

6. Time code indicator – the specific time of the 
current logging session 

7. Loudness Configuration – View of the 
connected meters’ Loudness settings specific 
for the logging session 

8. Instrument data – Loudness data overview for 
the current logging session 

9. Logging Chart – graphical overview of the 
logged data; Integrated Loudness and Peak 
level 
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1. File and Tools drop-down menus 
2. Selection of Logging Session or Logging 

Database 
3. Refresh Sessions, Filter Session or Data, Open 

Chart window 
4. Session List – Full list of all Logging Sessions 

contained in the currently selected database 
 

5. Export – Export logging data in various file 
formats  

6. Session Information – The basic info about 
what the logging session contains 

7. Loudness Configuration – View of the 
Loudness configuration used during the 
logging session 

8. Session Statistics – Top level summary of the 
Logged session data and statistics  

9. Session Data – All data entries of the specific 
Logging session 

Logging View 
 
Make sure you are in the ‘Logging’ view and connect your meter by hitting the ‘Connect’ button. 

 
Once your meter is connected, you are ready to start logging data. There are a few things worth knowing before 
initiating the logging of data:  
 

Session Information  

The Session information field is where you enter the top level information about what the specific Logging 
session contains, including; Title, Operator, Format and other notes.  
The Session information entry may be requested at the start of every session, edited during the logging session 
or altered in the Logging Database afterwards.  
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To define exactly how and when you prefer to enter your session information, please select ‘Options’ in the 
‘Tools’ dropdown and tick off your preferred approach in the Global options window.  

 

Instrument Information  

The Instrument information gives you a quick heads up on what meter the Logging application is currently 
connected to and ready to log data from.  

 

Loudness Configuration  

When connecting your meter to the Logging application, the meter loudness settings are retrieved and stored 
with every logging session. These settings may be changed inside the corresponding meter – you will need to re-
connect to the logging application to update the settings stored with logging sessions. 
The Loudness configuration is part of the session data, allowing you to always see how the specific session data 
were tracked.  

 

Instrument Data  

The Instrument data window, summarizes the overall loudness data of the reading indicated by the time-code, 
including time-code, Short-term Loudness Max/Min, Integrating Loudness value, Peak level, Channel and Count.  
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Logging Chart 

The Logging chart allows you to graphically follow the data entries as they are tracked during the Logging 
session.  
Note how the chart displays Integrating Loudness following the LKFS scale on the left side of the chart (default 
colour green), while the Peak Level is relating to the right side dBFS scale (default colour blue) 
Both data traces relates to the time-code on X-axis of the Logging chart.  

 
You have the option of opening several chart tabs at the same time in order to compare data. The charts will 
open up as separate tabs next to the Database tab.   
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In order to close a tab, please right click and select ‘Close tab’. 
 
Custom Chart Scales, Colour and Line Width 
Each of the two data trace lines on the chart may be customized to your liking on both Scale range, line colour 
and line width.  
 
Choose ‘Options’ from the ‘Tools’ drop-down menu and select ‘Chart options’. Point the relevant Chart line that 
you want to alter.  
The line width and colour may be chosen for each of the two chart lines. Choosing a new color will automatically 
align the color of the corresponding scale.  
 
The range of the scale may also be customized. The Logging application defaults to ‘Auto range’ and scales with 
the incoming logged signal. However, for more specific scale range wishes, the range may be defined and locked 
to a specific min/max position. This allows you to focus on the data within a more specific window of the 
measurement as well as making it easier to compare multiple charts on a graphical level, using fixed rather than 
dynamics scaling.  
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Database View 
The SQLite Session Database can hold all your Logging sessions and allows for advanced search, filtering as well 
as a complete overview of your sessions. 
Having created or selected the appropriate database, please select the ‘Database’ page of Logging Application. 
 
NOTE: The database file must only be accessed by one program at any time. Accessing the database file with 
more than one program might cause corruption of the file. Additionally please be aware that placing the SQLite 
database files on network file shares can reduce response time drastically, as well as cause multiple programs to 
access the same database. For further information, please refer to SQLite database documentation. 

Session List 

The Session list gives you an instant listing of all the Logging Sessions stored in the current database.  
If you do not see your latest logging sessions on the list, please hit the ‘Refresh Sessions’ button.  
Select the sessions you want to view by double clicking the Title in the Session List window. 
An active session can be retrieved while logging by hitting the ‘Refresh Session’ button. An active session is 
highlighted in green.  

 
Editing Session information 
You can alter the Session information, by right-clicking the specific session in the Session list and selecting ‘Edit 
Session Information from the pop-up window. 
 
Deleting a Session 
You may remove a session by selecting a session, right-clicking and selecting the ‘Delete Session’ point from the 
pop-up window. 

Filter Sessions  

The ‘Filter Sessions’ function allows you to perform targeted searches in your Session database.  

 
Hitting the ‘Filter Sessions’ button will bring up the Filter prompt, allowing you to type in a number of Session 
information filter criteria e.g. Title, Number, Operator Name, format or a specific data & time range that you 
would like to filter by.  
Hit the ‘OK’ button and the Session list will be filtered by your entered criteria. 
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Session Information & Loudness Configuration  

The Session information and Loudness Configuration windows are identical to their ditto in the ‘Session’ view. 
Please refer to the ‘Logging Session View’ section for further information. 

Session Statistics  

The session statistics window gives you a quick overview of key logged parameters from the current session e.g. 
Peak level Max/Min, Short-term Loudness Max/Min, Integrating Loudness Max/Min.  

 
By holding the mouse over a specific parameter, a small pop-up prompt will indicate the timecode of the specific 
data e.g. Short-term Max at 00:04:33:01.  

 
NOTE: If you are using the Filter Data function, the Session Statistics will reflect filtered data. Please see the 
‘Filter Data’ section for further detail. 
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Session Data  

The Session data window, shows all data entries of the specific session selected. This is also the data that may 
be filtered as well as exported for further data analyzing, visualization etc.  

 

Filter Data  

The ‘Filter Data’ function allows you to investigate your logged data by a number of user defined filter criteria. 

 
Hitting the ‘Filter Data’ button brings up the Data filter prompt, offering a wide range of Filter parameters 
including Timecode intervals, Peak level intervals as well as various Loudness intervals.  
Hit the ‘OK’ button and your session data will be filtered by the criteria you’ve selected.  
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When using the Filter Data, the overall Session Statistics min and max values will be determined by the specific 
filtered area, while the background calculation determining the specific min/max values will still be based on the 
entire session data.  
As an example, the below session data has been filtered to find Integrating Max for the time start/end slot of 
15sec – 1 minute.  
Eventhough the basis for calculating Integrated Loudness is the full session, the maximum integrated loudness in 
the filtered data (white area) is at 0.49 minutes, while the Full Session max. integrated loudness is at 2.43 
minutes. Similarly, the Peak and Short-term min and max values will express the chosen data value i.e. the 
min/max values of the filtered data.   

 

Session Chart  

The Chart function, opens up the Logging Chart from the Session (see Logging Session View section for more 
info) as a separate tab.  

 

Exporting Logged Data 

Hitting the ’Export’ button, will allow you to export all logged data of the current session as either PDF of CSV file 
format.  

 
The specific Export terms and information may be altered by selecting ‘Export Options’ in the ‘Tools’ ‘Options’ 
dropdown e.g. the basic PDF document information may be adapted to your desire.  
Hitting the ‘Export’ button of a chart, similarly, will export the current graphical representation.  
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Updating Your PAM PiCo  
How to Software update PAM 
PiCo 
TSL constantly develop new software features, facilities 
and adjustments to adhere to all relevant scale and 
Loudness recommendations.  
It is therefore recommendable that you, once in a while, 
check for new updates for your Meter on:  
www.tsl.co.uk/products.aspx  
 
Every PAM PiCo can easily be software updated via the 
inherent USB connector. 
Please follow these instructions to software update:  

- Go to www.tsl.co.uk/products.aspx  
- Go to the PAM PiCo product page  
- Locate the dkmeteronline.exe tool and download 
- Connect the PAM PiCo to your computer 
- Launch the PamPicoOnline application  
- The PamPicoOnline application will automatically check for latest software for your meter specifically. 
- Follow on-screen instructions to load the latest software.  

 

http://www.dk-technologies.com/
http://www.dk-technologies.com/

	Table of contents
	About this manual
	Important Notes
	PiCo Logging Application
	About the PiCo Logging PC Application
	Where to get a hold of the PiCo Logging Application
	Connecting Your PAM PiCo
	Connecting PAM PiCo to your PC
	Selecting or Creating the Logging Database
	Selecting your instrument


	The Windows & Functions
	Window Overview
	Logging View
	Session Information
	Instrument Information
	Loudness Configuration
	Instrument Data
	Logging Chart

	Database View
	Session List
	Filter Sessions
	Session Information & Loudness Configuration
	Session Statistics
	Session Data
	Filter Data
	Session Chart
	Exporting Logged Data


	Updating Your PAM PiCo
	How to Software update PAM PiCo


